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Introduction
Thank you for updating your TI-Nspire™ products to Version 3.2. This version of the Release Notes has
updates for all of the following products:

e TI-Nspire™and TI-Nspire™ CX Handheld Operating System Version 3.2

o TI-Nspire™ CAS and TI-Nspire™ CX CAS Handheld Operating System Version 3.2
e TI-Nspire™ Teacher Software Version 3.2

e TI-Nspire™ CAS Teacher Software Version 3.2

e TI-Nspire™ Student Software Version 3.2

e TI-Nspire™ CAS Student Software Version 3.2

These Release Notes are to help users who have been using TI-Nspire products and update their TI-
Nspire Handhelds and/or Computer Software to Version 3.2. These notes will help users see what
changes have been made in this most recent release, Version 3.2. Please make sure to update all of your
TI-Nspire products to the latest version to take full advantage of new features and enhancements. We
recommend updating your desktop software prior to updating your handheld operating system.

Instructions on how to update your TI-Nspire or TI-Nspire CAS handheld or software are linked below:

e Individual handhelds and software

e Concurrent and volume software licenses

Note: When updating TI-Nspire with Touchpad or TI-Nspire with Clickpad handhelds to the 3.2
Operating System, you will need at least 12MB of free space on the handheld. For updates to the TI-
Nspire CX or TI-Nspire CX CAS handhelds, you will need 15MB free space in order to perform the
Operating System update. You can find out how much free space you have on the handheld by
following these steps:

e OS Version 1.7 or earlier: Press HOME (@), 8:System Info, 4:Handheld Status
e 0OS Version 2.0 or later: Press HOME (&), 5:Settings & Status, 4:Status

To make additional space on your TI-Nspire handheld either delete documents or move them to your
computer until you have updated the OS.
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1. New Graphing Features

There are new graphing features added into the TI-Nspire Graphs application with version 3.2. These
new options provide templates for linear and conic equations you can graph. In the 3D Graph view,
there is a new 3D Parametric graph type.

To get to the linear and conic equation templates, insert a Graphs application and open the Menu.
Select option 3: Graph Entry/Edit. You will see the new option of Equation added to the list of graph
types. Select 2: Equation to see a full list of the new graph types.

Graphs & Geometry 2

R 1:Actions 4

(L]
2:View 8

HU 3:Graph Entry/Edit v I A} 1:Function
mdt_:Windowauom v _\Fﬂ:une ,

r_\j S:Trace b -A-‘lv 3:Parametric —\H— 2:Parabola *+
A&l s:Analyze Graph " | g aPotar P zcice
|ii| 7:Table g + S:Scatter Plot $ 4:Ellipse  *
@;g:eenmetry ' IE §:Sequence ¢ >+<5:Hyperbola 4
+Tl 9:5effings. . ' jg 7:Diff Eq $ &:Conic v

Note: The equation graphs are identified by el, e2, €3, etc. They are listed in the graph editor list
separately from the functions (y1(x), etc).

To be able to enter a 3D Parametric graph, insert a Graphs application and open the Menu. Change to
3D graphing by selecting 2: View then 3: 3D Graphing. Once in the 3D view, open the Menu again and
choose 3: 3D Graph Entry/Edit to access the Parametric option.

Graphs & Geometry =
[%- 1:Actions 4
AL
g:\fiew b
‘@ 3:3D Graph Entny/Edit ’ | @ 1-Function
I
/"\
‘@; S:Trace ’

+ﬂ, 6:5ettings. .. R

1.1 Linear Equation Graphing

To see the templates for graphing linear functions, open the Graphs menu and select 3: Graph
Entry/Edit, 2: Equation, 1: Line. The templates include the slope-intercept form (y = mx + b),
vertical lines (x = c), and the standard form of a linear function (ax + by = c). Select any of these
options and the template will be pasted into the Graph Entry line. You can input values for any of
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the coefficients of the equation. Use the tab button or the arrow buttons to move from one field to
another within the template.

2 x+3 y=4

O
b
1.
]
.)}‘

Linear Equation Template Linear Equation Graphs and Function

1.2 Conic Graphing

For Conic Graphing, access the Graph Entry/Edit menu and choose Equation. Options 2-6 offer
templates for various forms and types of conic graphs: specific templates for parabolas, circles,
ellipses and hyperbolas and a general template for the equation of a conic.

k 1: Actions » ; X k 1: Actions k 1: Actions »
2: View » B12: View 512: View >
}:3: Graph Entry/Edit BJ|\. 1: Function 3! Graph Entry/Edit pf'L. 1: Function #}:3: Graph Entry/Edit #| L 1: Function
TE 4 - 1: Line M2 Equation » w4 -1 Line p|<> 2: Equation  » T 4: -1 Line | 2: Equation  »
(5 |VH2: Parabola MW (1,5 1% 2: Parabola  »||4- 3: Parametric L5 1% 2 Parabola M|/ 3: Parametric
ot 6: €D 3: Circle WY 2 p=a-x?+b x+e ‘e {©2d0 ‘46 4 3: Circle »
2071 4: Elipse M4 3 x=a-(y-k)°+h =071 4: O 2: a-x*+ta-y*+h-xtc-y+d=0 =17 1€p 4 Ellipse
o 8 (A€ 5 Hyperbola WeE 4 x=a-y*+b-y+c oi g (€5 Hyperbola M2 6: Sequence P o4 8 €S Hyperbola
4l 9: {9 6: Conic ML 7: Diff Eq | 1l 9: {9 6: Conic M|I2 7: Diff Eq 1l 9: 19 6: Conic
£l ‘a #1lx |a &)
Parabola Templates Circle Templates
k 1: Actions » k 1: Actions
I 2: View » g0 2: View

13 Graph Entry/Edit pfl*lL 1: Function
T3 41 Line »| 2: Equation b
7, 5: 1% 2: Parabola M|/ 3: Parametric
Y& 6 1 3: Circle »| o8 4: Polar

57 1€ 4: Ellipse pf|l: 5: Scatter Plot
o4 8 (€5 Hyperbola |2 6: Sequence

11h 9

13 Graph Entry/Edit pfl*lL 1: Function
T3 41 Line »| 2: Equation b
7, 5: 1% 2: Parabola M|/ 3: Parametric
146 1 3: Circle »
57 1€ 4: Ellipse »
o 8 (€5 Hyperbola>
1] 9 { 6: Conic

#16 = #16 B

Hyperbola Templates General Conic Template
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Some examples:

N > Conic ==
767% 5. 76 %y 7.61 %y
L3
2 2
N op b2 1
; 05 . 2% 32 f
|4 53 )5 1184 %
5. 16 ! 13,84 \ / 1507 ! .95
R 1 %1 o2 G-1?
el x=—-(y—2)2+1 22 32
-5.66 2 515 5 72

The Analyze Graph tools are extended with the following specifically for conics:

O 1:Center
. A=
|3§t §:Analyze Graph .f‘i}em 1:Zero O 2\ertices
A 5 ini
i 2:Minimum @ 3:Foci
atel N
':\,m 3:Maximum \l} 4:Axes of Symmetry
}"4:Interse-:ti0n U S:Directrix
=
?inr S:Inflection _L\: 6:Asymptotes
Q; 6. dyfdx ® 7:Radius
:Integral €= g:Eccentricity

The context menu for a conic graph also provides access to only the Analyze Conics functions
supported by that specific conic graph. You can access the context menu by right-clicking (PC
software), Command-clicking (Mac software) or pressing [en]then on the conic graph.

For the examples above this may result in:

iR > Conic =

-
el =¥ — =
_ 2
5. 15 427 ‘5\:/(2 105 ) il sy H
2 2
el x=i-(y—2)2+1 el e-2) +(y—1) =1 3
2 515 22 32 572

N1

**Note that these screen shots are taken by using TI-Nspire™ CAS as the value of the characteristics are exact for irrational values.
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Also new in TI-Nspire version 3.2 is the ability to draw Conics as a geometric object.

@ 1:Points & Lines » | e Ellipse based on three points: both foci
m@ — and a point located on the
o ellipse
¢” 3:Measurement » 2:Triangl .
& _ I z2Trange e Parabola based on one point (focus) and
X 4constrcton +| [7] 3 Rectangle a geometric line (directrix) OR
.+ * STranstormation » | {7 4:Polygon based on two points (focus and
@ S:Regular Polygon vertex)
m e Hyperbola based on three points: both foci
| 7:paravola and a point located on the
- hyperbola
DGS Hyperbola i . .
e Conic based on five points located on
0 9:Conic by Five Points .
the conic

Y parabola

x=-2

{2,0]
1 1

—_

1.3 Graphing x = g(y) Functions

You can now easily graph inverse functions in the x = g(y) format. The new x = ¢ template
described in section 1.1 above only allows you to plot vertical lines. With the Text tool, you can
enter ANY function in the format of x = g(y). In the Graphs application, select the Menu and
choose 1: Actions, then 7: Text. The text tool appears in the Graph screen. Click anywhere to
create a text box and start entering text. Type in x=sin(y) and press ENTER.

Next press ESC to exit the Text tool and get your pointer back. To get the graph of x=sin(y) to
appear, grab the text (by pressing (1] then Click on the TI-Nspire handheld or by clicking on it in the
TI-Nspire Software) and drag it to either axis. The graph will appear on the screen. Release the
graph (by clicking to release it on the TI-Nspire handheld or by dropping it on the axis in the TI-
Nspire Software).
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x=sin [}:l

.67 667 .67

1.4 Graphing Inequalities x < g(y),x > g(¥),x < g(y),orx = g(y)

You can also graph inequalities in the forms of x < g(¥), x > g(y), x < g(¥), orx = g(y) in the
same manner as you graph x = g(y). First, select the Text tool from the Graphs menu (1: Actions,
7: Text). The Text tool appears on the graph screen. Click anywhere on the Graphs screen to create

a text box. Enter a vertical inequality, such as x < 5 and press ENTER. Next press ESC to exit the
Text tool and get your pointer back. Grab the text (by pressing (en] then Click on the TI-Nspire
handheld or by clicking on it in the TI-Nspire Software) and drag it to either axis. The graph will
appear on the screen. Release the graph (by clicking to release it on the TI-Nspire handheld or by
dropping it on the axis in the TI-Nspire Software).

x<5

€.67 6,67 : €67
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1.5 Lined Grid
There is a new option on how to display the Graphing Grid. In the Graphs application, select the
Menu, then choose 2:View, 6:Grid. This menu allows you to choose No Grid, a Dot Grid or a Lined

Grid.

gl

Lined Grid — Square Aspect Ratio
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1.6 3D Parametric Curves

The addition of 3D parametric curves increases the types of surfaces that can be plotted, such as
lines, planes, spirals, spheres, etc.

To graph using 3D parametric equations, open a Graphs page, open the Menu and select 2: View, 3:
3D Graphing. Next open the Menu and select 3: 3D Graph Entry/Edit, 2: Parametric. Then type the
equations into the appropriate spaces, using the down arrow key to proceed to the next space (the
Tab button will not navigate you between the equation fields).

xpl (tu)= -3+43¢ xp2 (Lu) = -3+3-r4u xp3 (tu) = coshul- *:3+cos".1,‘*‘)
I ypl (tu)= 343:¢ E‘ B w2 tw= 343020 IE‘ I yp3 (tu) = sinlu)-[3+cosls)) IE‘
pl (tu)= 3437 R p2 (tu) = 3+3-rtu @ 3 (Lu) = cinle) @

xpd (tu) = 5 cosly) xp5 (Lu) = 2-sinlz) xp6 (tu) = 3 sinlu) coslz)
B w4 tu= 5l E B w5 tu= 2-cosle) E B w6 cw= 3 :iniu) sinle) El
pd (tuy= 7 @ 5 (LU= u @ 2p6 (tu) = 3 coslu) @
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The option Aspect Ratio is added to the Range/Zoom menu:

[} 1:Actions ’
NE
2View ,
(%] 3:3D Graph EntryEdit »
Y4 4Range/Zoom & ?‘é 1:Range Settings...
22\
@ 5Trace | BE 2 Aspect Ratio ..

+Tl 6:Settings... » | 1% 3:Shrink Box (= or <)

:’i 4:Magnify Box (x or >)
:kf 5:x-y-z Orientation (o)
I_ 6:x-y Orientation (z)

ZL,, 7:y-z Orientation (x)

L, 8:x-z Orientation ()

2. Variable Bin Width for Histograms

With TI-Nspire version 3.2, you can now define the bin widths for histograms. You will need to create a
list that will define the classes for the histogram. Once you have created a list that you wish to use for
the definition of the classes, you can access the Data & Statistics menu and select 2: Plot Properties, 2:
Histogram Properties, 2: Bin Settings, 2: Variable Bin Width. The Variable Bin Width Settings dialog box
will appear and you can select the name of the list that you created to define the classes.

If you create a list of bin boundaries {1,4,6,8,9}, it generates the classes [1,4), [4,6), [6,8) and [8,9). Note
that the final number is not inclusive. You must make sure that all data points belong to a class.

score
=randint(1,10,17)

[ OK l Cancel ‘

[
A score KL Bin Width Settings Dialog Box
Definition of “bounds” list to set the bin widths
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1.1 jf1.2 1.3

9.
> 4 >
g e 6
L S
o (=

2, (T
L -1 L 3_

O T T T T T T T T T T T T O T T T 1 T T T T T T T

01234567 8910112 012 32 4567 8 310N

score score
Default Bin Width Bin Width as defined by the list ‘bounds’

3. 2D Template for Indices
A template for subscript/indices had been added to the 2D templates in TI-Nspire version 3.2. You can
access the entire catalog of 2D templates using the [=&] button on the TI-Nspire handhelds or the Utilities

tab ( B ) within the Document Toolbox on TI-Nspire software. The template appears as Dn .
Indices can be used to define variables, which in turn, can be used in interactive linked multiple
representations.

| 12 B *ndex —

17 Distance between two points
f l Ala,.a, )witha, =-3.55 and a, = 2 55
Alasa-,
S B(b,.b,) with b, = 1.96 and b, = 1.5
N is equal to:
. < TBlbsb) a
T flfhz—hxlh\faz—a;]l = 6.116
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4. New CAS functionality

The CAS functionality of TI-Nspire CAS (including TI-Nspire CX CAS handhelds, TI-Nspire CAS Student
Software and TI-Nspire CAS Teacher Software) is extended with the “domain” command. To enter the
domain command, either type it using the alphabetic keyboard or locate it in the catalog.

m<x<-1 or 1<«

v
4/99

In addition, several new operators for logical tests have been added:

Test 3
Equal To =
Mot Equal To x<3 = =3 frue
Lesz Than

<

Less Than or Equal To X=23 = x<3 x£3
Greater Than i
Greater Than or Equal To |x 2‘{0 = -2<x<2 e
o —2l<0 = -22x<2 ue
nand
notr X2 or xF2pe=-2 false
no
ar |
xor
- ™
=
Is Prime 5/99

5. Chemical Notation

Chem Box is a new feature in TI-Nspire version 3.2 that allows you to easily input chemical formulas and
equations into a Notes or Question application. Chem Box uses a simple set of rules to adjust the
formatting of subscripts and superscripts more easily. In the Notes application, select the Menu, then
choose 3: Insert, 2: Chem Box (or use the shortcut Ctrl+E on your TI-Nspire handheld or TI-Nspire PC
software or Command+E on the TI-Nspire Mac® software).

i TI-Nspire™ Technology Version 3.2
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jﬂ 4:Format 2:Chem Box (Ctr+E)
|} 5:Math Box Options » AA 3:Shape b
j‘z f:Calculations b [ ,,.] 4:Comment ’ l

This will open a Chem Box into which you can type a chemical formula or chemical equation. For
example, if you enter CaCO3, the 3 will be automatically formatted as a subscript. Superscripts may be
entered by selecting the » key before the sign and value of a charge. For example, if you enter PO4/3-
(use the minus sign rather than the negative sign to get the best display of the charge) in a Chem Box, it
will be formatted as PO,>. When entering a chemical equation, the + key will separate two reactants or
products, and the = key will result in the insertion of the “yields” symbol. Press ESC to exit the Chem
Box tool. Chem Box can also be inserted into the question or answer fields in a Question application.
The Chem Box will only help you format text to appear as chemical formulae. It does not recognize
whether you want Co for Cobalt or CO or Carbon Monoxide; you will need to check capitalization to
make sure you enter the correct symbols. The Chem Box will not perform any chemical calculations.

14 mm *Reactions — o[l] x|
Consider the decomposition reaction below. What is the correct formula for the phosphate
B -
CaC0, — Ca0 + COy on
®|A pos-
O|B
{ .| C ‘
[ .| D l
Chem Box feature in Notes Application Chem Box Feature in Question Application

6. User Interface Updates
Several User Interface updates have been made for TI-Nspire version 3.2. This section highlights the
changes.

6.1 Streamlined Application Menus

The TI-Nspire Application menus have been streamlined to help make it easier to find the most
common tasks you’ll need within each application. The example below shows the Graphs menu on
the TI-Nspire CX handheld as it appeared in version 3.1 (below left) and how it appears now in
version 3.2 (below right). Notice that there are 12 options at the top level of the TI-Nspire version

‘ TI-Nspire™ Technology Version 3.2
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3.1 Graphs menu (numbers 1-9, plus options A, B, and C). The same menu in the TI-Nspire version
3.2 Graphs menu features only 9 menu options.

[ 1iRctons el il L3 1: Actions
< View 3 5 2: View M,
£ 3: Graph Type :

T3 4: Window { Zoom % 3: Graph Entry/Edit p
(1, 5: Trace F 4 Window / Zoom »
| 6: Analyze Graph A\, 5: Trace >

»
»
»
»
« 7. Points & Lines » \t 6: Analyze Graph
‘ ==
»
»
»

& 8 Measurement

»
3
»

(©)9: Shapes ! w0 : !

1 A: Construction . 8: Geometry

.. B: Transformation 11l 9; Settings. ..

@ CiHints i

@ rilx)- B filx)] &
Menu as it appears in TI-Nspire version 3.1 New streamlined menu in TI-Nspire version 3.2

6.2 New Collapsible Toolbar Added to TI-Nspire Software

There is a new toolbar added to TI-Nspire desktop software. This toolbar contains access to the
application menus and text formatting options. To access or hide the toolbar, simply click on the
hide/show arrow in the center of the toolbar (see the red circled area below):

& “DocumentT - TI-NSpire™ Teacher Software

File Edit View Insert Tools Window Help

Content Documents

4 . Q - A - |mnspiesans |7~ A« A B I/QN\ ABC

~“Document! X 408

11 Sefings DocumentView: [ | B | zoom: [200% -| - +

This toolbar provides you access to the application menus so that you can have a different view
(such as the TI-Nspire SmartView emulator or the Page Sorter view) in the Documents Toolbox
panel.

6.3 Improved Formatting of Text, Math, and Chemical Notation
You can now apply standard text formatting to the text, math boxes, and chemical notations you
enter in the Notes and Question applications. In TI-Nspire desktop software, the formatting tools

‘ TI-Nspire™ Technology Version 3.2
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are located in the new toolbar described in section 3.2 above. On TI-Nspire handhelds, you can
access the formatting options by selecting the desired text (use the [esnijkey and the directional keys
to select the text you wish to format). Then choose the context menu by pressing the[e]then
(menjand select Format text. This option provides a dialog box in which you can choose the font style
and size, bold, italics, underline, superscript, subscript or strikethrough. The context menu also
includes the option Color, 3:Text Color to change the color of the selected text.

Now text can have more than one type of formatting: italics and bold and underlined at the same

time!

NOTE: While in Computer Mode in TI-Nspire Teacher or TI-Nspire Student Software, you can choose
to use any of the fonts installed on the computer. The TI-Nspire handhelds only support the TI-
Nspire and TI-Nspire Sans fonts. If you author a document in Computer Mode using a font style
other than TI-Nspire or TI-Nspire Sans and then transfer it to a TI-Nspire handheld, the font style will
be displayed as TI-Nspire Sans. The selected font information is retained in the document, so the
selected font will be displayed when the document is viewed in Computer Mode again.

6.4 Zoom Capabilities for PublishView™ Documents

In previous versions of TI-Nspire desktop software, you could not control the size of the PublishView
documents that you view and interact with. Now, much like the zoom setting that allows you to
change the size of the handheld view, you can adjust the zoom of a PublishView document. The
Zoom controls are located along the bottom of the TI-Nspire software application window next to
the Boldness setting. By default, Zoom is set to 100% but can be adjusted between 10% and 500%.

Algebra 1 - Begin Class =

Documents

= Bl - @ 5 -

B-EE |w
Do oeine = -
R The Oil Refinery Problem
Graphs & Geometry =
Jg 1:Actions In the figure below, use your mouse to move the cursor so
B 3 viow that it is on top of the open circle at point G. Then click

A and hold and slowly drag point G to represent Trial 1
3:Graph Entry/Edit

T 4Window 7 Zoom

mostly land, then Trial 2 mostly water,
then Trial 3 GH = 200 ft.

G srrace 4

Mgt 6:Analyze Graph

£ 7:Table B distanice from A to H 30 u
&4\ 8 Geomatry distance from G to H 337u

163 u

R T Py

#1] 9:settings

distance from F to G

258 u

TiNspire™ Applications

BUN
01438

from B to GG

Water point G (B

H

F (&
Land

I

»

“Document! x| Doumentd x| —Documentd x| il Refinery Froblem x|

= 0 clients connected 0 0f 24 Students logged in

Settings. Document View:

4p @

- +

{'} TEXAS INSTRUMENTS

Zoom set to 100%
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6.5 Hyperlink Enhancements in PublishView™ Documents

The Hyperlink feature for TI-Nspire PublishView documents has been enhanced to support relative
hyperlinks for creating lesson bundles that can be shared with colleagues or students. You can enter
a hyperlink in the same manner as you did in previous versions of TI-Nspire, but now you’ll see a
more descriptive option for linking to a file:

Hyperlink

Text: 'T].rpe your text here.

FE

—

Address:

Link to a file on your computer or network drive.

f.tj Link to an Internet resource.

l OK H Cancel ‘

The first option now allows you to link to files on your computer or a network drive. If you create a
zip file that contains the PublishView document and other documents that are linked from it, the
hyperlinks you create will now remain intact when the zip file is extracted on a different computer.
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6.6 Dragging a TI-Nspire Screenshot to Other Applications

This feature will be especially useful to users of Interactive Whiteboards. When you have either the
TI-Nspire SmartView emulator or the TI-Nspire keypad visible within the Document Toolbox panel,
you can drag a screenshot directly from the TI-Nspire software to another software program (such
as Microsoft® Word or PowerPoint). The yellow areas outlined in red in the images below show
where you can click to drag off a screenshot:

Documents Toolbox Documents Toolbox

As you drag the screenshot off of the emulator or keypad, a ghosted image of the screenshot will
appear. You can drag the screenshot and release it into any third-party program that allows you to
insert or paste an image. NOTE: the screenshot is automatically stored into the Clipboard. This
makes it very easy to paste the screenshot into several places and into several different applications.
The screenshot is also stored in the Screen Capture Window of the TI-Nspire software.

7. Conditional Behavior of Objects

If you create your own interactive documents, this feature can help make your efforts easier. You will
now easily be able to define the behavior of objects in your documents. For example, you can make text
appear and disappear. Conditional Attributes allow you to dynamically hide, show, or change the color
of graph or geometry objects based on user input, variable values, or calculated expressions. Common
uses include clicking a slider to reveal steps in sequence or dynamically changing the color of a point
based on its position on the screen.
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Conditional Attributes may be set and used on both TI-Nspire™ handhelds and TI-Nspire™ computer
software. The Conditional Attributes dialog is invoked through object context menus or through a new
Set Conditions tool in the Actions menu for Graphs and Geometry. To access the Conditional attributes
from the Graphs or Geometry menu, select 1: Actions, 5: Set Conditions.

In the example below, the line color (outside of the circle) and the fill color (inside of the circle) are
determined by the value of the variable, a, which is controlled by a slider.

mm il > *Unsaved <

Conditional Color

mm iBcl > *Unsaved <

Conditional Attributes

The value of the expression determines the
Show When: | a | object color.
Line Color: | atl | II ﬂ II
Fill Color: | a+3 | a 9 10

Colors...’ @ |Cancel‘ n e i

Conditional Attributes Dialog Box Conditional Color Dialog Box defining values for
each color

mm Il » *Conditionals <

Color Settings for Circle when a=1 Color Settings for Circle when a=2
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8. Lua Script Editor

TI-Nspire version 3.0 introduced the support for TI-Nspire documents written using the Lua scripting
language. In that version, you had to use a third-party editor to create and edit your Lua scripts. New in
version 3.2, TI-Nspire Teacher Software and TI-Nspire Student Software include a new script editing
environment built-in to the product. The Script Editor can be accessed by selecting the Insert menu.
Next choose Script Editor then Insert Script. The TI-Nspire Script Editor window will open and you will
be prompted to name the script.

The Lua Script Editor is not a feature of any TI-Nspire handheld. You can use documents that are written
with Lua on the TI-Nspire handhelds, but you must create and edit the Lua script using the TI-Nspire
Teacher Software or TI-Nspire Student Software.

i Script Editor

File Edit Debug View Help
—— — -
= = H

Suspend Focus Enable Insert Set
Script Script Breakpoints Image Permissions

Script Title

Enter title for this script.
|

0K Cancel

Caonsale Globals Call Btack Locals

For details about the TI-Nspire Script Editor functionality, please see the chapter on the Script Editor in
the full TI-Nspire version 3.2 Guidebook.
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